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Quick Start Tutorial

Introduction

This document provides all the basic knowledge to help you develop your first TSX Nano
PLC application using PL7-07 programming software.
It is divided into four parts :

1 Required hardware configuration for PL7-07
2 Installing PL7-07 programming software
3 Main menu bar
4 Programming tutorial (using example)

1 Required hardware configuration

1.1 Compatibility

The following class and/or types of computers can run the PL7-07 programming software:

• IBM PC-AT compatible machines

• Programming terminals

- FTX 417 20/ 417 40 (1)

- FTX 507.55 or FTX 507 6B/8C/8T/9T(1)

(1) recommended terminals for optimal performance

1.2 Configuration

The computer system should meet these minimum requirements:

• minimum 286 CPU, recommended 386 CPU or higher (running at least 20 Mhz)

• 640 kB of RAM and 2 megabytes of available extended memory

• 3 megabytes of available hard disk space

• EGA, VGA, or SVGA monitor

• One available COM serial port—COM1 through COM4

• One parallel port for printing—LPT1 through LPT4

• MS-DOS version 3.3 or higher

Typical configuration
• 286 microprocessor or higher

Although the PL7-07 PC programming software will run on a computer with the minimum
requirements above, you may experience slow performance if you have multiple
windows open simultaneously, a large amount of animated data, or a very large
application.
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2 Installing PL7-07 programming software

The PL7-07 PC programming software is contained on two, high-density 3.5" diskettes.
To install the PL7-07 PC programming software:

1. With the DOS prompt at c:,  insert installation Disk #1  in the 3.5" floppy disk drive.
2. Select the floppy drive by typing a: or b:  at the DOS prompt and press <enter> .
3. Type install . Press <enter>  to launch the PL7-07 PC programming software.
4. Select the language for installing the program. The PL7-07 PC programming

software can be installed in one of five standard languages : English, French,
German, Italian, and Spanish. Other languages can also be installed using a disk
(supplied separately) containing the files translated into the required language.
The PL7-07 PC programming software can only operate in one language at a time.
If support for multiple languages is required, create a new directory with a different
name and reinstall the software in the new directory. If you reinstall the software in
the same directory as the original installation, the newly-installed version will
overwrite the old one.

5. When prompted, select a target drive for installing the PL7-07 software.
6. When prompted, select a name for the PL7-07 PC programming software directory.

The default sub-directory is <drive>\PL707.
7. When prompted, select a communications port for the PLC.
8. The program decompresses the installation files and writes the PL7-07 PC program-

ming software files to the selected drive.
9. When prompted, insert installation Disk #2  in the floppy drive.
10. Respond Yes or No, (see note) to the prompt: «May I create/modify your CONFIG.SYS

file if needed (Y/N)?
11. Respond Yes or No, (see note) to the prompt: «May I create/modify your

AUTOEXEC.BAT file if needed (Y/N)?
12. When prompted, insert installation Disk #1  in the floppy disk drive.
13. When prompted, press any key to terminate the installation program and reboot the

computer.

Note: If you responded No in steps 10 and 11, write down the data displayed at the end of the
installation program to manually update your configuration files. Before terminating the installation
program, modify your configuration files as follows:

1. Display your AUTOEXEC.BAT file in a text editor. Insert the statement, C:\PL707, to the path
statement:
PATH=C:\WINDOWS;C:\DOS;C:\PL707
where C: is the drive selected and \PL707 is the name selected for the PL7-07 PC
programming software directory.

2. Display your CONFIG.SYS file in a text editor. Insert these statements:
FILES=30 or more
DEVICE=C:\PL707\DUNTLW.EXE PROFILE=C:\PL707\DUNTLW.001
COM1 is the default communications port. To change the COM port setting, edit
DUNTLW.001 in directory C:\PL707. In the Basic Parameters section, change the COM

setting in the line PORT=COM1:O,8,1 to the desired COM port.
3. Reboot the computer.
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3 Main menu bar

The main menu bar below is shown on launching the software :

File To create, save, store, print, close an application, and exit the
software.

Edit To cut, copy, paste, replace, or find an item in a List or Ladder
program.

View To select one of the five editors, the Cross Reference tool, the
Validate Errors display, or to select a preference for either the List
or Ladder Editor.

Tools To perform a specialized action in an editor. The Tools menu is a
contextual menu; the options it displays change from editor to
editor.

Configuration To configure a hardware or software resource of the PLC.
PLC To transfer an application between the programming terminal and

the PLC, to connect and disconnect the programming terminal
from the PLC, to view PLC operations, and to animate the
program logic and data variables.

Window To select or close a window.

Help To display help text.
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4 Programming tutorial

4.1 Introduction

A program is made up of a series of instructions which are executed by the PLC
processor in order to give commands to outputs based on input data read by the same
processor.

PL7 enables programs to be written in either List or Ladder program instruction set. The
following Ladder rungs and List sequences are equivalent expressions. In this tutorial,
we will develop this program logic in the Ladder Editor.

4.2 Presentation of the example

List sequence Ladder rung 0

LD %I0.0
OR %Q0.0
ANDN %I0.1
ST %Q0.0

List sequence Ladder rung 1

BLK %TM0
LD %Q0.0
ANDN %M0
IN
OUT_BLK
LD Q
ST %Q0.1
END_BLK

List sequence Ladder rung 2

BLK %TM1
LD %Q0.1
IN
OUT_BLK
LD Q
ST %M0
END_BLK
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Ladder  is a diagrammatic language that uses both graphic elements and text. A Ladder
rung is the collection of Ladder programming instructions that constitute one complete
logical unit. The structure of the Ladder rung is relatively straightforward. The rung,
which starts with the upper left connection of the rung to the left power rail, is a set of
instructions, in series and in parallel, that lead to some output or outputs. If, when the
Ladder rung is scanned, the input logic solves true, then the output instructions are
enabled or energized.

List is a Boolean text-based instruction set. A List sequence is a collection of List
program lines that constitute one complete logical unit. In either Ladder or List, you write
instructions in the logical order required to control a machine or process.

List sequences always begin with a Load (LD), Block (BLK), or an unconditional List
instruction, such as an unconditional jump instruction. The three List sequences shown
on the previous page each start with a Load or Block instruction. Each sequence is
complete when the next Load, Block, or unconditional instruction is encountered in the
program.

4.3 Development methodology

This tutorial is divided into eight steps that show you how to insert the three rungs shown
on the previous page :

Step 1 Set up (page  6)

Step 2 Insert rung 0  (page 12)

Step 3 Insert rung 1  (page 18)

Step 4 Test application  (page 22)

Step 5 Edit rung 1  (page 25)

Step 6 Insert rung 2  (page 28)

Step 7 Re-test

Step 8 Document application  (page 33)
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c:\>

c:\cd pl707

c:\PL707>pl707

(1)

Initial

4.4 Step 1 - Set up

• Run PL7-07 PC programming software

1. Enter this access path:
c:\PL707.

2. Type : PL707. Press
<enter> .

The main window is
displayed. The main menu
bar displays four active
menu items - File, PLC,
Window, and Help. The
other menu bar items are
grayed out.

The status bar (1) displays
the word "Initial" to indicate
that no application is open.

• Open a new file

Select New from the File
menu
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The items in the menu bar
that were grayed out in the
initial state are enabled.

The status bar reads
"Offline" to indicate that
an application is open,
but that the PC is not
communicating with the
PLC.

The main window displays
Ladder by default the first
time it is used.
After this, the default display
mode (List or Ladder)
corresponds to the last
display mode used in the
previous session.

• Select the programming environment

To toggle from one display
mode to the other, select
List Editor or Ladder Editor
in the View menu.

In this instance, we have
used the Ladder display.

Offline
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• File name

1. Select Save from the
File menu to name an
application file.

2. In the File Selection
dialog box, overtype the
asterisk in the Filename
field with a name that meets
DOS file naming standards.
(8 characters max.). Select
OK.

• Viewer

The Ladder Viewer window
is displayed. You can scroll
through a program in the
Ladder Viewer window
while you create a rung in
the Ladder Editor.
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To display the Ladder
Editor, select Insert Rung
from the Tools menu.

• Editor

The Ladder programming
environment has two tool
bars and one instruction
bar:

(1) Ladder Editor tool bar

(2) Ladder Viewer tool bar

(3) Ladder Editor instruc-
tion bar

• Editor tool bar (1)

Each button corresponds
to an option in the Ladder
Editor tools menu.

(2)

(1) (3)

Help
Toggle Grid

Next Rung
Previous Rung

Clear Rung
New Rung

Cancel Rung
Validate Rung

Offline
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• Ladder viewer tool bar (2)

Each button corresponds
to an option in the Ladder
Viewer tools menu.

• Editor instruction bar (3)

Each button corresponds
to a Ladder instruction. The
+...F10 button displays the
Extended Ladder palette,
with additional instructions.

The area at the far right of
the instruction bar displays
the name of the instruction
currently selected.

• Grid

The data area of the Ladder
Editor had a programming
grid with rows of cells.

The area at (1) is a cell . (2)
is a selected cell . Use the
mouse pointer or the cursor
keys to select a cell.

Grafcet step table
Toggle Ladder/List

Toggle List/Ladder

Help
Toggle Grid

Toggle Rung XXX
Delete Rung 3 Lines Address and Symbol

Edit Rung 3 Lines Address or Symbol
Insert Rung 1 Line Address and Symbol

Show Address
Show Symbol

function keys shift + function keys

Normally closed contact

(2)

(1)
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Select

Place Cursor keys

Select        Place

• Selecting an instruction

You select an instruction
from the instructions bar
and place it in a cell using
the mouse or the keyboard.

- Mouse

To select an instruction,
click the left mouse button
on an instruction in the
instructions bar.

To place an instruction, click
the right mouse button in a
cell.

- Keyboard

To select an instruction,
press the corresponding
<function key> .

To place an instruction, use
the cursor keys to select a
cell and press the
<spacebar> .
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(1)

4.5 Step 2 - Insert rung 0

4.5-1 Insert instructions

1. Select a normally open
contact by clicking the left
mouse button on the
contact in the instruction bar
or by pressing <F2>.

2. Place a normally open
contact by clicking the right
mouse button in a cell. Or,
select a cell with the cursor
keys and press the
<spacebar> .

The selected cell is shown
by a red line (1). The contact
is shown in solid lines
beneath.
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3. Select a normally closed
contact.

4. Place a normally closed
contact.
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5. Select a coil.

6. Select the cell after the
normally closed contact.

7. Place the coil. The
horizontal connector is
inserted automatically and
the coil is inserted in the
last cell.
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8. Select a down connector
and then the desired cell.

9.  Place the down
connector.

10. Select another contact
and place it in the cell
beneath the first contact
to complete the graphic for
this rung.
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4.5-2 Insert addresses (operands)

1. Select the cell in which
you want to insert an
operand.

2. Double-click on the cell
or press <enter> .
A text insertion box is
displayed.

3. Type an operand in the
text insertion box.
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4. Press <enter> .
The insertion box closes
and the operand is
displayed above the
graphic instruction.

5. Repeat these steps to
enter the remaining
operands. The rung is now
complete.

6. Select New Rung from
the Tools menu. In this
example, we selected the
option from the Ladder
Editor tool bar.

"New Rung" validates rung
0 and copies it to the Ladder
Viewer. The Ladder Editor
programming grid is cleared
to prepare for a new rung.
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4.6 Step 3 - Insert rung 1

1. Select a normally open
contact from the instruction
bar and place it in the first
cell.

2. Select a normally closed
contact from the instruction
bar and place it in the
second cell, after the
normally open contact.

3. Select a Timer function
block from the instruction
bar.
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4. Select the cell after the
normally closed contact.

5. Place the Timer function
block after the normally
closed contact.

The cell outlined in grey
shows the relationship of
the selected cell to the
resulting function block. A
function block occupies 2x4
cells.
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6. Select a coil from the
instruction bar. Select the
cell after the function block.

7. Place the coil. The
horizontal connector is
automatically inserted.

8. Insert operands %Q0.0,
%I0.2, and %Q0.1.
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9. Select the function block
%TM0 by double-clicking
the mouse pointer on the
block (or select the block
with the cursor keys and
press <enter> ).

The Timer dialog box is
displayed.

10. Select these values :

Preset value = 1
Timer Type = TON.
Timebase = 1 second.

Select OK.

11. Validate the new rung
by clicking on the button
"Validate Rung".
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4.7 Step 4 - Test application

1. Select Connect  from
the PLC menu.

The PLC should be in Stop
mode.

2. If you have a different or
no application in the PLC,
you are prompted to select
whether you want to trans-
fer one of the applications
or monitor the application
in the PLC.
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Select PC -> PLC to transfer
(overwrite the application).
If you are prompted to
change the application
version, select PLC
Version Management in
the configuration menu.

The status bar displays :
"PLC Connected" to
indicate a successful
connection :
- "Mem:" to display the
number of bytes in the
program,
- "Stop" to indicate that the
PLC is not running; "Online"
to indicate that the terminal
is connected to the PLC.

3. Select PLC Operations
from the PLC menu.

4. Select Run on the PLC
Operations window.
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An information dialog box
appears. Select OK to run
the PLC program.

The Run LED turns on.

5. Toggle the switch at 
input %I0.0 (1).

The LEDs for input %I0.0
and for output %Q0.0 are
turned on. Then the LED at
%Q0.1 turns on.

6.  Close the PLC
Operations dialog box.

(1)It is advisable to use a 24VDC input simulator : TSX SIM 06 (for TSX 07 10 I/O), TSX SIM 09
(for TSX 07 16 I/O) or TSX SIM 14 (for TSX 07 24 I/O)
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4.8 Step 5 - Edit rung 1

Edit rung 1 which was created in step 3 (page 18) as follows:

• Stop the PLC

• Reset Timer Timebase value to 100 ms.

• Reset Timer Preset value to 5.

• Change the operand of the normally closed contact from %I0.2 to %M0.

1. Select Stop in the PLC
menu.

An Information  dialog box
appears.
Select OK.

2. To edit rung 1, first select
any cell in the rung or select
the rung 1 header.
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3. Select Edit current rung.

4. Select the function block
%TM0. Double-click on the
function block or select it
with the cursor keys and
press <enter> .

5. Select the new values :

Preset value = 10.

Timer Type = TON.

Timebase = 100 ms.

Select Ok.
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6. Change the operand of
the normally closed contact
%I0.2 to %M0.

7. Select New Rung .

The Ladder Editor validates
the rung, copies it to the
Ladder Viewer, and clears
the Ladder Editor for rung
2.
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4.9 Step 6 - Insert rung 2

1. Insert the graphic instruc-
tions and the operands for
rung 2.

2. Select the Timer function
block.

Double-click on the function
block with the mouse
pointer or press <enter> .

3. In the Timer dialog box,
select these values :

Timer = 1

Preset value = 20.

Timer Type = TON.

Timebase = 100 ms.

Select Ok.

4. Select Validate Rung.
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4.10 Step 7 - Retest application

1. Select Connect from the
PLC menu. Follow the
prompts until the application
is on the Online state.

2. Select PLC Operations
from the PLC menu.
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3. Select Run  from the PLC
Operations window to run
the program on the PLC.

An information dialog box
appears. Select Ok to run
the PLC.

The Run LED turns on.

4.  Toggle the switch
connected to input %I0.0.

5. Close the PLC Operation
dialog box.
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6. Select the Data Editor
from the View menu.

7. In the Data editor, select
Insert to display the Data
Object Edit dialog box.

8. In the Data Editor dialog
box, insert %TM0.V, the
current value of the Timer 0
variable. Select Ok.

The variable is inserted in
the Data Editor.
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9.  Insert 5 more data
variables : %TM1.V,
%Q0.0, %Q0.1, %I0.0,
%I0.1.

10. Select Toggle
Animation from the PLC
menu.

The Current Value of the
variables changes as the
program runs.

11. Stop animation by
reselecting Toggle
Animation  from the PLC
menu.
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4.11 Step 8 - Document application

4.11-1 Insert comments

1. Stop the PLC.

2. Select a rung header, by
double-clicking on it with
the mouse pointer, (or
select a rung header using
the cursor keys and press
<enter> ).

The rung header dialog box
is displayed.

3. Type a title for the rung in
the Title  field, and
comments about the rung
in the Comment field.

Select Ok.

The rung header displays
the rung title and the first
line of comments.
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4.11-2 Print application

1. Select Print Setup  from
the File menu.

 2. The Print Setup  dialog
box appears.

In the Output To  field
select:
Printer  then select the
communication port.

In the Printer Setup field
select:
- the type of printer.

In the Paper Size  field
select:
- the size of paper.

Select Ok.

You can also define:
- the margins,
- the cover page,
- text for page headers and

footers,
- a comments page.

For more information, see
Section C.15 of the TSX
Nano/PL7-07 manual.
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4. In the Print dialog box,
select the application parts
that you want to print.
We have chosen to print
the Ladder program and the
configuration data.

5. In the Print dialog box,
select Configuration/
Settings .

6. In the Configuration Print
Settings dialog box, select
"Timers" to print all Timer
configuration data.

Select Ok.
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7. In the Print dialog box,
select Ladder/Settings .

8. In the Ladder Print
Settings dialog box:
- Select All in the Range
field to print all Ladder
rungs.
- Select the type of attribute.

Select OK.

9. In the Print dialog box,
select Ok to begin printing
the file.

A partial printout is shown
on the next page.
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 Timer Configuration

 +-%TMxx-+-Type+-TB-+Preset+-Adj-+-----Symbol-------+
    | %TM0  | TON | 100 MS| 0010 | YES |                                |
    | %TM1  | TON | 100 MS| 0010 | YES |                                |
    | %TM2  | TON | 1 MN  | 9999 | YES |                                |
    | %TM3  | TON | 1 MN  | 9999 | YES |                                |
    | %TM4  | TON | 1 MN  | 9999 | YES |                                |
    | %TM5  | TON | 1 MN  | 9999 | YES |                                |
    | %TM6  | TON | 1 MN  | 9999 | YES |                                |
    | %TM7  | TON | 1 MN  | 9999 | YES |                                |
    | %TM8  | TON | 1 MN  | 9999 | YES |                                |
    | %TM9  | TON | 1 MN  | 9999 | YES |                                |
    | %TM10 | TON | 1 MN  | 9999 | YES |                                |
    | %TM11 | TON | 1 MN  | 9999 | YES |                                |
    | %TM12 | TON | 1 MN  | 9999 | YES |                                |
    | %TM13 | TON | 1 MN  | 9999 | YES |                                |
    | %TM14 | TON | 1 MN  | 9999 | YES |                                |
    | %TM15 | TON | 1 MN  | 9999 | YES |                                |
    | %TM16 | TON | 1 MN  | 9999 | YES |                                |
    | %TM17 | TON | 1 MN  | 9999 | YES |                                |
    | %TM18 | TON | 1 MN  | 9999 | YES |                                |
    | %TM19 | TON | 1 MN  | 9999 | YES |                                |
    | %TM20 | TON | 1 MN  | 9999 | YES |                                |
    | %TM21 | TON | 1 MN  | 9999 | YES |                                |
    | %TM22 | TON | 1 MN  | 9999 | YES |                                |
    | %TM23 | TON | 1 MN  | 9999 | YES |                                |
    | %TM24 | TON | 1 MN  | 9999 | YES |                                |
    | %TM25 | TON | 1 MN  | 9999 | YES |                                |
    | %TM26 | TON | 1 MN  | 9999 | YES |                                |
    | %TM27 | TON | 1 MN  | 9999 | YES |                                |
    | %TM28 | TON | 1 MN  | 9999 | YES |                                |
    | %TM29 | TON | 1 MN  | 9999 | YES |                                |
    | %TM30 | TON | 1 MN  | 9999 | YES |                                |
    | %TM31 | TON | 1 MN  | 9999 | YES |                                |
    +---+--+---+---+--+----------------+
 (* CONDITIONS  *)
   (* CONTROL OF TIMER TM0  *)

   (* CONTROL OUTPUT 1 WITH A TIMER  *)
   (* WHEN OUTPUT 0 IS ON, TIMER 0 IS ENERGIZED AND THE LIGHT  *)
   (* TURNS ON. THIS ALSO STARTS TIMER 1. WHEN TIMER 1 TIMES *)
   (* OUT, TIMER 0 STARTS AGAIN. *)

    (* CONTROL THE FLASH RATE OF OUTPUT 1 *)
   (* AFTER TIMER 0 TIMES OUT, AN INTERNAL STORAGE BIT IS  *)
   (* TURNED ON. THE INTERNAL STORAGE BIT (%M0) RESETS TIMER  *)
   (* 0, WHICH TURNS OUTPUT 1 OFF. THE COMBINATION OF TIMERS *)
   (* 0 AND 1 PRODUCES A FLASHING. *)
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